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Dear friend! Before using the program, please read the Guidelines. We strongly recommend that
you read the chapter "Tips and tricks".
Pic. 1
Terms and Abbreviations
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Application - any software (program) designed to perform a specific function
directly for the user. Application programs use the services of the computer's
operating system and other supporting programs.
Clipboard - a software facility that can be used for short-term data storage
and/or data transfer between documents or applications, via copy and paste
operations. It is usually implemented as an anonymous, temporary data
buffer that can be accessed from most or all programs within the
environment via defined programming interfaces.
Modal window - a child (additional) window that requires users to interact
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with it before they can return to operating the parent application, thus preventing the workflow on
the application main window.
Root directory - the "highest" (the first or top-most) folder in any folder-based hierarchy. The root
folder contains all other folders and can also contain files. For example, the root folder of disk "C" is
C:\
The program directory - the folder "ChessArchive" that contains the executable file of the program
"ChessArchive.exe" and all accompanying folders and files. If the program was installed to default
directory, this folder is located on disk "C" in "Program Files" directory (see Pic.1).
CC - chess composition(s) - in this case - chess problem(s)
DB - database
PC - personal computer
Compatibility and system requirements
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The program is compatible with the following operating systems:
Windows 98 / ME / NT / 2000 / XP / 2003 Server / 7

Minimum system requirements:
- PC-compatible computer
- 512 Mb RAM size
- monitor (display) with screen resolution from 1024x768 pixels
- input devices, such as PC keyboard and PC mouse
The purpose and the main features of the program
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Chess Archive is a multifunctional Windows desktop application intended for creating a personal DB
of chess compositions (meaning only composer's own works including those in coauthorship) in
electronic format.
Main features:
- creating and editing of CC including versions (only orthodox pieces are supported, no fairy pieces)
- searching for the CC according to different criteria (genre, author, publication source, number of
units, stipulation, solution, keywords)
- customizable list of publication sources and list of keywords
- group viewing of CC belonging to the specific genre (10 diagrams on the screen)
- displaying of some files relevant to the DB (to view publication and anticipation)
- generation of four notation types: Forsyth-Edwards notation (FEN), international (FIDE), english
and russian algebraic notations
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- converting of selected data to the following electronic formats: fancy (for the program "Fancy" by
Marek Kwiatkowski), olive (for the program "Olive" by Dmitri Turevski), yacpdb (for the online chess
problem DB www.yacpdb.org)
- the support for alternative text (for instance, info in different language)
- printing of current CC
- export/import of the DB
Internal structure and safety facilities of the DB
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The actual DB file ("bdChessArch.mdb") consists of two independent MS Access tables - the
compositions table, called here "main section" and the versions table ("versions section"). The
relationship between these tables is provided by the executable file of the program
"ChessArchive.exe".
The virtual DB file ("bdChessArch.ldb") is created in operative memory of your PC when you run
the program. The user performs all operations with that file. Any changes in the virtual file is not
reflected in the DB until the user applies the command that write all changes to the actual DB file
(the click on "Save" button in the windows of CC creating/editing).
Thus, even an emergency situation (e.g. sudden power off the PC at the time of CC
creating/editing) cannot lead to loss or distortion of available (previously stored) information in the
DB.
For enhanced protection, Chess Archive does not support the removing of any CC (including
versions) from the DB by the use of program interface. The program only allows editing the data of
a CC that is already available in the DB.
Installation of the program
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Unpack the program archive "chess_archive.zip" to any folder on your PC, run the file
"ca_setup.exe" and follow the instructions that appear on the screen. It is recommended to install
the program to default directory - C:\Program Files\ or to the root directory of a selected disk, for
example, D:\
Using the program
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Upon the first launch of Chess Archive you will see the message "Database of the program is empty
...". Click the "OK" button, select a genre (menu "Genre") and begin creating the DB (Create -> new
composition).
Creating/editing of CC
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Creating and editing of CC (including version) are realized from the menus "Create" and "Edit",
respectively. By choosing "new/current composition" or "new/current version" the modal windows of
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CC creating/editing will be opened for creating/editing of CC of the main section/versions section,
respectively. The difference between these windows is only in the fact that the window of version
creating/editing does not contain the field "Keywords" (the keywords can be assigned only to CC of
the main section). Therefore, below we shall consider the actions in the window "Create/Edit the
chess composition".
The "Author" field consists of two lines, the upper - the main text (author's name in native
language), lower - the alternative text (author's name in foreign language). The field has a limit on
the total number of characters - not more than 102. If you had filled the template "Author" (Settings
-> User's templates), the field would be filled initially with the mentioned template data when
creating each new CC (including version).
The "Source" field also supports alternative text and has the same limitation (maximum - 102
characters). For example: "Problems and Studies" (the top line) and "Zadachi i etjudi" (the bottom
line). By setting the cursor in this field, the list-box of publication sources (in alphabetical order)
opens automatically. This list can be edited, if desired (see more about this in the chapter "Settings.
Sources"). By left click on some line its contents is copied from the list-box to the field. To close the
list-box just left click on the window background. The program allows entering data into the field
"Source" manually, for instance, you can write the distinction of current CC before the publication
source name and you can enter the publication date after that one.
Initial position of CC can be set up in two ways:
1) by manipulations with pieces-box by copying the needed piece from the box to diagram;
2) by pasting the position in Forsyth-Edwards notation (FEN) into the empty field "FEN" (at the
bottom of the window) from the clipboard (manual input of FEN is not supported). The following
characters are allowed in FEN-notation: K - king, Q(D) - queen, R(T) - rook, B(L) - bishop, N(S) knight, P - pawn, / - separator, 8 - empty rank. The white pieces are denoted with capital letters,
and the black ones are denoted with lowercase letters. If the FEN is correct (i.e. no misprints in
characters), the initial position of CC will be displayed on the diagram. When editing the initial
position by means of FEN paste (from the clipboard) you have to pre-clear the field "FEN" by
pressing the "Backspace" key.
Indicate the stipulation under the diagram to the left (the field is limited to eleven characters;
some data are required). Be attentive when specifying the stipulation: it must conform to the
current genre name that is displayed above the field "Anticipated".
The condition (or twins) is located slightly to the right of the stipulation. The field supports the
inputting of alternative text into the bottom line; the total number of characters is limited to 82. For
example: "b) Bd1 -> f8" (the top line) and "b) Ld1 ->f8" (the bottom line).
If CC has not been tested for soundness, set up the value "C-" in the area "Test" that is located to
the right of the pieces-box; the default value is "C+".
The "Anticipated" field displays a path to some file that is associated with the created/edited CC
and that contains an information about anticipation (if this fact was established, of course). For
instance, any graphic file or pdf-document can be specified as the file. To specify the path to that
file, first, it needs to be placed to the folder "Anticipated" in the program directory (see Pic. 1), and
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then it needs to be selected in list-box by clicking the button labeled ">>" (to the right of the field
"Anticipated"). Later it will be possible to open the file from the main program window by clicking
the button "Anticipated" (see Pic. 2) when viewing the CC.
The similar actions should be performed to specify the file confirming the fact of publication of
created/edited CC (the "Publication" field). First of all the file has to be placed to the folder
"Published" in the program directory (see Pic. 1). Later it will be possible to open the file from the
main program window by clicking the button "Published" (see Pic. 2) when viewing the CC.
Potentially the folders "Anticipated" and "Published" may contain a large number of files. So in
order to avoid a mess we advise to systematize the names of these files by such a way that would
be clear how they relate to certain CC. For instance, for the third version of the problem number 53
in "Helpmates" genre it would be logical to name the file "h_53_3".
The "Solution" area is intended for inputting of solution and the author's comment pertaining to
the created/edited CC. This area has no limit on the number of characters and allows alternative
text inputting 1. To input the latter, press "Enter" at the end of the main text, print "@" (without
quotes), again press "Enter" and then enter the alternative text. For a better perception of the data
in this area the text can be formatted with spaces and blank lines. Some data in this area required:
if the "Solution" area does not contains at least one character, the program will not allow saving the
data.
The "History" area is intended for text information reflecting the major milestones in the history
of created/edited CC (creation date, when and where it was sent, etc). An example of data
presentation at this area is given in "Settings. User's templates". As a matter of fact you are able to
enter any text information into the area. There is no limit on the number of characters; alternative
text inputting is not supported. Formatting is by spaces and blank lines.
The "Keywords" area is optional (the user selects some keywords in drop-down list when the
cursor is in this area; manual input is not supported) and involves the assignment of the keywords
corresponding to the form and the content of created/edited CC. When viewing CC the keywords are
not displayed (in the main window), since they are only needed to search for CC in the DB. The area
has a limit on the total number of characters (up to 170). The list of keywords is editable (see more
about this in the chapter "Settings. Keywords").
All the fields and areas in the creation/edition windows (except for the "Keywords" area) support
clipboard operations (copy, cut, paste). For instance, you can copy the text that contains a solution
of some CC from any file (or from application frame) and then paste it into the "Solution" area.
To save the entered information click on the button "Save". On this command Chess Archive
makes an incomplete checking of initial position on the legality (there must be exactly one king to
each side, the total number of pieces of each side - no more than 16, pawns - no more than 8, a
pawn cannot be located at the first and/or eighth rank) and, if the legality is ok, copies the entered
information to the DB file. Otherwise, you will see a message like: "Illegal position! Check out the
Kings."
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Control elements of the main program window (Pic. 2)
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Pic. 2

1 - the main menu of the program, its functions will be described below.
2 - navigation buttons (viewing the CC of current genre):
<< - go to the first CC of the current genre (keyboard shortcut: up-arrow);
<1 - go to the previous CC (keyboard shortcut: left-arrow);
1> - go to the next CC (keyboard shortcut: right-arrow);
>> - go to the last CC of the current genre (keyboard shortcut: down-arrow).
3 - the area that indicates the current CC number. Total number of CC (except the versions) of
current genre is displayed under the elements 4 and 5.
4 - the field of entering of specific CC number (by hand) for subsequent transition to it by means of
clicking the button "Go to Nr" or by pressing "Enter".
5 - the button "Go to Nr" - transition to the CC that number was entered into the field 4.
6 - the button "-->" - appears in case of presence of at least one version of the current CC and
provides entrance to the versions section. When clicking this button, the total number of versions of
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current CC and also navigation buttons (the current version number, you are viewing, is indicated
with red color) appear to the right of the button; and the button icon will change to "<--". Click on
this button again to exit the versions section.
7 - the button "< -- >" - if active, switches the mode of the native/alternative text displaying (for
details, see the chapter "Creating/Editing of CC"). When displaying the alternative text, the button
icon takes the following image: "< A >". Click it again to return to the native text mode. Switching
of display mode can be done by pressing F2 function key on PC keyboard.
8 - the button "Anticipated" - if active, opens a file that is associated with the current CC and that
contains some information about anticipation (for details, see the chapter "Creating/Editing of CC").
9 - the button "Published" - if active, opens a file that is associated with the current CC and that
contains some information about the current CC publication (for details, see the chapter
"Creating/Editing of CC").
Main menu functions
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- The "File" menu contains seven commands:
1) "Position+" - opens the modal window "Position +" in which the initial position of the current CC
is displayed in four different notations (as well as stipulation and total number of units of each side),
including current version. That window can be initialized by pressing F10 function key when the
application is active.
The buttons "Fancy" / "Olive" / "yacpdb" convert the data of the current CC to the code for the
program "Fancy" / "Olive" / online chess problem DB (http://www.yacpdb.org), respectively. All the
codes are created as plain text file (rewritable txt-file, saved in the folder "Converted" in the
program directory). After the file has been created it is automatically opened with the system utility
"Notepad" (a simple text editor "notepad.exe"). By default, the generated code contains data
presented with the native text; if required, set the value "alternative" in the parameter "text".
It is assumed that the user already has a collection of CC in fancy format. To add the generated
code to the collection, first, it is needed to copy the code to the clipboard. Then, you need to open
the existing fancy-collection with a simple text editor, such as "Notepad", and paste the clipboard
contents into the collection (after the last string, leaving one blank line). After that you need to
change the number of the added CC within the line that reads "Dg [1] = new Array", i.e. replace "1"
in "Dg[1]" with the number following by the order after the number of the last CC in the initial
collection. To finish the work you have to set the cursor at the end of the last character of the code
and press "Enter" key twice. Then, you need to save changes (File -> Save). That is all - the code of
new CC is added to the fancy-collection. Sometimes you may need to correct the stipulation and (or)
condition in the added CC. That can be done manually by the use of "Fancy" application (the fields
"Stipulation" and "Condition") 2.
Adding the olive-code to an existing olive-collection is even easier. Run the "Olive" application
and open the collection that you want to add the current CC of Chess Archive DB to. Copy the
generated olive-code to the clipboard, then activate the Olive application and place the cursor at the
end of the frame with the elements of the collection. Call the context menu by right-click and select
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"Paste" - the CC will be added to the olive-collection! 3.
Yacpdb-code (yaml-syntax is used) consists of 11 parameters that contain information about the
current CC. Because the value of each parameter has a specific look, then, as a rule, there may be
need to correct the generated yacpdb-code by hand. How to do that, see on the web site
http://www.yacpdb.org.
2) "Search" - opens the modal window "Search" in which the user makes a search query by
specifying search parameters. That window can be initialized by pressing F5 function key when the
application is active.
The search includes three optional (the user selects a defined value) and five arbitrary (the user
specifies the condition in a free form) parameters.
The optional parameters are:
- Localization ("Search:"). By default the program searches for requested data in "the current genre"
that is indicated in the main window. If you want to search for data in two or more genres, select
the value "the whole Database".
- Number of objects on the diagram ("Number of units:"). The default value is "any", i.e. from 3 to
32 ("miniature" - from 3 to 7, "Meredith" - from 8 to 12, "more than 12 units" - from 13 to 32).
- Keyword search. To be included in a search query, the keywords need to be selected in the list of
available keywords (left click on a keyword and click on the "Add" button. The "Remove" button
deletes highlighted keyword from the list of selected keywords, and the "Reset" button removes all
the keywords from the list of selected keywords that were added to the search query (i.e. clears the
list).
When searching for two or more keywords they are combined with the logical AND operator. For
example, three keywords were selected: "Battery mate", "Model mate" and "Zilahi". - The program
will be searching for CC that all three of those keywords was assigned.
The arbitrary parameters are presented with the fields: "Author", "Source", "Stipulation,"
"Solution" and "History." Values of these parameters are set manually or by means of paste
operation and the values may contain any characters (an apostrophe ' is replaced with ` because it
is a technical character). There are two input fields for each of the search parameters. If you use
both, the search would yield results that match the first field as well as the second (i.e. they are
combined with the logical AND). For example, if you put "8=R" and "8=Q" into the "Solution" fields
then the search will look for CC with white rook and queen promotions in the solution. The
"Stipulation" fields work in a little different way. The first field is intended to be the exact match of
entry stipulation (e.g. "h # 2") and the second field to be the substring of entry condition or twin,
(e.g. "circe"). To run the search click on the button "Find".
The search is not case sensitive and takes into account even partial matches of the values of
arbitrary parameters to corresponding contents of the DB cell. For example, the DB contains two CC,
in which there are two names: Goodwill (in the one CC) and Gorovich (in the other CC) as the user's
coauthors. It is enough to enter "go" into "Author" field to find the CC with the names of both
coauthors 4.
All the values (optional and arbitrary) are combined on the logical AND principle (was described
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above) in a search query. User-defined query is saved as a temporary data; it is displayed when
performing the next search. Use the button "Reset" to delete the value of corresponding search
condition.
The data, corresponding to the search conditions, are displayed in tabular form in the additional
window "Search result" that always opens on top of the main program window. There is no need to
explain the contents of all columns in mentioned tabular form except probably the "Version" column.
The character "-" means that specific CC has no versions; "+" indicates that the CC has at least one
version. By clicking on a row in the tabular form (or by pressing "Enter") you are able to view
diagram position of corresponding CC that will be displayed in the main program window.
The search results may be sorted according to different criteria ("Order by:"). The default value is
"composition number" (meaning the serial number of CC in any genre); the alternate mode is by
"number of units" (meaning the total number of pieces of both sides in each CC). If the search
results do not fit the window, use the scroll-bar (to the right of the table of results) to move through
the table by means of PC mouse pointer (scrolling by means of PC mouse wheel is not supported).
You can also use the keys "down-arrow" and "up-arrow" to scroll through the table.
3) "Overview" - opens the modal window which displays - in a reduced form - ten CC of current
genre (diagram, author, source, stipulation, condition/twins). That window can be initialized by
pressing F6 function key when the application is active. The number of CC
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is marked with red

color. There is the navigation bar at the bottom of the window. To jump to the CC with a certain
number enter it into the text field and click the button "Go to Nr" (or press "Enter") - the CC will
appears in the upper left corner of the window. Use the arrow buttons for navigation (the viewing
step is 10 diagrams); the outer buttons make the transition to the first and the last CC of current
genre.
4) "Print" - sends the current CC to printer 6. This function can be initialized by pressing F7 function
key when the application is active. In addition to the basic data (diagram, author, source, number of
units, solution) the program allows to print an additional text information at the page header
(printed with bold font type in one line above the basic data) and at the page footer (printed with
normal font type in four lines under the basic data). For details, see the chapter "Setting. User's
templates".
The print function is a weak point of the program: when we were testing Chess Archive with
different Windows versions, there were some errors, not all of them are fixed yet. Also there is no
print preview. Please see our recommendations for printing below under the "For advanced users".
5) "Export" - opens the modal window "Database Export" that is intended for making a backup copy
of the current DB on a hard disk or removable storage device such as flesh drive 7. The DB export
onto optical disk is not supported. The window "Database Export" can be initialized by pressing F8
function key when the application is active. Follow the onscreen instructions.
When exporting the DB to selected disk (receiver), the folder "ChessArchive" will be created on
that disk. The following content has to be copied into this folder: the actual DB file
(bdChessArch.mdb), the current list of keywords, the current list of publication sources and the
contents of the folders "Anticipated" and "Published "(see Pic. 1) located in the program directory.
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The purpose of these folders is explained in the chapter "Creating/Editing of CC".
6) "Import" - opens the modal window "Database Import" that is used to copy previously exported
DB into the program directory 8. That window can be initialized by pressing F9 function key when
the application is active. Follow the onscreen instructions.
When importing, the current DB (including the empty DB) is substituted with imported DB.
7) "Exit" - quit the program.
- The "Genre" menu displays the preset DB structure in the form of eight traditional genres of chess
composition. After choosing the specific genre in this menu the user can begin viewing the CC in
that genre and he will be able to create/edit CC in it.
- The "Create" menu contains two commands:
1) the "new composition" and 2) the "new version" - they open the modal windows "Create/Edit
the chess composition" and "Version of composition Nr ..." respectively (see more about this in the
chapter "Creating/editing of CC").
- The "Edit" menu contains two commands also:
1) the "current composition" and 2) the "current version" - they open the same windows as the
menu "Create" for editing previously saved data.
- The "Utilities" menu potentially includes 7 commands that run executable files (exe-files); it is
designed to quick launch those applications that the user may use when working on Chess Archive,
such as the solving programs. Initially the menu contains a single command that launches the utility
"CA Converter". Some other commands can be added by the user via the menu Settings -> Utilities
that will be described below in the chapter "Settings. Utilities".
- The "Settings" menu contains six commands:
1) "Language +" - choice of the program interface language (english or russian), choice of the
program windows background and the program audio alerts on/off switch.
2) "Pieces" - choice of pieces set (click the "OK" button to select the set).
3) "User's templates"

9

- contains text fields that filling may be useful while creating the DB and for

printing of CC.
The text, entered by the user into the field "Page header"/"Page footer", is displayed above/below
the basic data, respectively, only in a printed document. In the header, for instance, you can write
the name of the composing tourney, and in the footer - contact details (author's postal address, email).
The text entered in the "Author" template will be automatically copied to the field "Author" when
creating every new CC (including versions) that would save a little time creating the DB. As the
alternative text we mean the author's name and surname written in another (non-native) language
that may also be useful when printing the current CC to be sent to foreign competition.
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The text area "History" (in the main program window) was designed as a subsidiary area
containing additional information about current CC related to its history. Therefore in purpose of
data uniformity presented in this area the user is able to create a template that contains up to ten
words or phrases that may also be helpful when searching for CC on the content of the area
"History". For example, the template may contain the words: (in parentheses - that the user will
point to a specific CC), "CREATED:" (date), "SENT:" (date), "PUBLISHED:" (yes/no) "DISTINCTION:"
(yes/no), "FA:" (the publication data in the FIDE Album), "PDB:" (a unique number in PDB - the
online chess problem DB http://www.softdecc.com/pdb/index.pdb), "yacpdb:" (a unique number in
yacpdb - the online chess problem DB http://www.yacpdb.org).
4) "Sources" - opens the list of publication sources (it is usually opened with system utility
"notepad.exe" - simple text editor "Notepad"). You are able to edit the list manually by removing
unnecessary sources and by adding the new ones. Do not forget to save all changes (File -> Save).
The list of publication sources saves time creating/editing the CC and unifies information about the
publication that may be useful when searching for CC by the contents of the field "Source".
5) "Keywords" - opens the modal window "List of keywords". This window allows you to remove the
keywords that, in your opinion, will never be needed and add those that you consider useful. As a
matter of fact you can completely replace the initial list of keywords with your own list. When adding
new keyword try to use short names, because the number of keywords assigned to each CC is
limited
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. Remember, all changes of the list take effect after clicking the "Save the list" button.

6) "Utilities" - opens the modal window "Utilities" in which the user is able to select up to six
external programs (for instance, solving programs) that can be launched from the "Utilities" menu in
the main program window. To do that, enter the name of external program (by hand) and click on
the button labeled ">>" to specify the path to executable file of desired program. By clicking that
button the modal window "Choose a file" will be opened. The files and folders of selected disk are
displayed in the left column, and the executable files, available in the opened folder, are displayed in
the right one (any folder opens by double left-click).
- The "Info" menu, we believe, needs no explanation.
Keyboard shortcuts
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Chess Archive provides the possibility of using the keyboard shortcuts for quick access to some
functions
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. In particular, the navigation in the main section of current genre can be done by

pressing the "arrows" keys:
- up-arrow key - go to the first CC of current genre
- left-arrow key - go to the previous CC
- right-arrow key - go to the next CC
- down-arrow key - go to the last CC of current genre
Eight function keys can be used in Chess Archive:
F1 - opens the help-file you are reading now
F2 - switching "the native/alternative text"
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F5 - calls the "Search" function
F6 - calls the "Overview" function
F7 - prints the current CC
F8 - calls the Database Export function
F9 - calls the Database Import function
F10 - calls the "Position+" function
"CA Converter" utility

[ Back to Contents ]

CA Converter is a micro program that is intended for batch converting of selected database elements
in one of three electronic formats: fancy, olive

12

and yacpdb. The utility runs from the main window

(menu "Utilities") and has an intuitive user interface. All parameters are optional, the user just need
to specify them by selecting the certain value and click the "Convert" button. The resulting
converted file is saved in the folder "Converted" located in the program directory (see Pic. 1).
NOTES:
1

For instance, writing the solution using an alternative notation.

2

We advise to make backup copy of fancy-collection before adding a new CC, since inexpert actions

of the user may cause damage to the collection.
3

If required correct information about the added CC on the "Metadata" tab in the "Olive" program.

4

The program searches in the main section (the compositions section) only; the versions section is

not involved.
5

The "Overview" shows CC of the main section only; the versions section is not involved.

6

Before printing the CC you can alter the text in the "Solution" area right in the main window. The

changes will be reflected in print but the contents of the corresponding DB cell will stay unchanged.
7

The exporting facility can only backup the DB to the root directory of a storage device.

8

The importing facility can only restore the DB if the backup data (a folder named "ChessArchive")

resides in the root directory of a storage device.
9

For changes to take effect you have to restart the program.

10

You cannot assign keywords to versions.

11

Keyboard shortcuts are enabled when Chess Archive is active and provided neither any modal

window nor the main program menu is opened.
12

If the text information presented in the database is not in Latin characters, it is necessary to

resave the converted olv-file with utf-8 encoding. This can be done using a simple text editor such
as "Notepad", i.e. open the file with the extension ".olv" and resave it, changing its encoding in
dialog box.
For advanced users
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More printing options
Install a virtual printer application that prints to pdf-file (for example, "Universal Document
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Converter") Set it as a default printer. Then print any CC from Chess Archive. Open the resulting
pdf-file with the "Adobe Reader" and adjust the printing settings to fit your needs (menu "File" ->
"Print ..."). After that print the pdf-file with a real printer. The print quality of pdf-files is not perfect
but something has to give...
Editing the database manually
You may need to change the DB manually when, for example, the initial position of a certain CC is
illegal (for instance, there is only one king). In that case, you have to make some changes to the
appropriate cell of the table in the DB file "bdChessArch.mdb" located in "PathDoc" folder in the
program directory. Open the file, select the table ("tblMeChessVersii" - table of versions) and make
the appropriate changes in the FEN cell ("Notatia" column). The edited CC will be displayed in the
main program window after saving the changes. Keep in mind that the program will not allow to
save the changes if there is only one king in the initial position (or there are three kings etc) when
re-editing of the CC, using the "Edit" menu.
Using the other sets of pieces
You may substitute sets of chess pieces used in Chess Archive with some other sets, keeping
extension, name and dimensions of graphics files in the subfolders "Default", "Double", "Small"
(used in "Overview" function) and "Standard" located in the folder "Figures" in the program
directory.
Tips and tricks
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We advise to start your work with Chess Archive with filling the user's templates (Settings ->
User's templates) and editing the list of keywords (Settings -> Keywords).
We also recommend editing the list of publication sources by removing unnecessary ones and by
adding new sources (Settings -> Sources).
We recommend using the program in tandem with a solving program since Chess Archive has no
engine to check the solution of CC, and a mistake in the initial position might give the author some
trouble. It is assumed that the user will be using "Problemiste" (the solving program by Matthieu
Leschemelle) while creating the DB, that is: to setup the initial position of a CC, to check its solution
and to copy FEN to the clipboard (Board -> Copy the Board...). "Problemiste" is user-friendly by the
fact that FEN is already selected in the modal window "Copy the Board", i.e. it is ready to be copied.
Perhaps, even more ergonomic in this respect is the program "Olive" (recently developed by Dmitri
Turevski), because the FEN is displayed in the main window (in the text field above the diagram).
You just have to select the FEN with PC mouse and press the keys "Ctrl" + "C" simultaneously on PC
keyboard - FEN will be copied to the clipboard, then, you need to activate the CC creating/editing
window in the Chess Archive, place the cursor in the "FEN" field (pre-clearing this field by
"Backspace" key, if it is not empty) and press "Ctrl" + "V" simultaneously - paste operation will be
done and the initial position of the CC will be displayed on the diagram!
We strongly recommend making backup copies of the DB (after some changes of the DB) on a
removable device such as flash drive (File -> Export). This measure will allow you to restore the DB
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quickly in case of hard disk failure.
Troubleshooting
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If an error occurs while the program is running (for instance, in search function), please do the
following. Close all running programs (including those in the startup folder). Enter the program
directory, open "DLL&OCX-ChessArchive" folder and run "_Setup.bat" file. Then reboot your PC. If
the error persists, please contact technical support.
Uninstallation of the program
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the first way: enter the program directory, run "Uninstall.exe" file and follow the instructions that
appear on the screen.
the second way: Start -> All Programs -> Chess Archive -> Uninstall.exe (left-click)
the third way: enter the Control Panel (for instance, from the "Start" menu) and double-click on
"Add/Remove Programs" applet. Then select "Chess Archive" from the list and click "Add/Remove"
button.
ATTENTION! The uninstallation of the program will destroy your DB of CC completely. If you need
the DB, please save it before uninstalling by means of the export procedure (File -> Export).

FREQUENTLY ASKED QUESTIONS
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What number of chess compositions is it possible to create within one genre?
Answer: the minimum is one CC; the maximum number is practically (visually) limited to the fourdigit number i.e. 9999.
How many versions of one composition can I create?
Answer: the minimum is one version; the maximum number is practically (visually) limited to the
two-digit number i.e. 99.
I cannot open the help-file (Info -> help). What should I do?
Answer: first, make sure that this file ("en_help.chm") is located in the program directory (see Pic.
1). If the help-file is missing, you can download it from the program web site (zip-archive, 110 KB).
The help files with ".chm" extension are opened with system utility "hh.exe" which is usually located
in "WINDOWS" folder on disk "C". Perhaps, this utility is absent on your PC or it is outdated. You can
download the file "hhupd.exe" (716 KB) from microsoft.com and run it on your PC. That file will
update the utility "hh.exe", and then the problem with opening chm-files should be eliminated.
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How do I remove CC from the database?
Answer: the removing of CC (including the versions) from the database is not supported in Chess
Archive. The action that is equivalent to removing of unneeded CC is its data editing with complete
change of the data (the number of edited CC will remain the same).
What file may be placed into the folders "Anticipated" and "Published"?
Answer: any file with extension that is associated with default application, in other words, the file
that is normally-opened on your PC.

TECHNICAL SUPPORT
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Before you contact us, please do the following:
1. Be sure that you are doing everything right. We all make mistakes sometimes...
2. Read attentively the information contained in the chapter "Compatibility and system
requirements" or read "ReadMe_en" file that is located in the program directory. The file can be
opened from the main program window (Info -> about) by clicking on logotype of the program.
3. Make sure that your system configuration corresponds to the minimum system requirements as
well as to the compatibility requirements.
4. Read the chapter "FREQUENTLY ASKED QUESTIONS": it may already contain an answer to your
question.
5. Do the actions which are described in the "Troubleshooting" chapter.
But if you still have a problem with Chess Archive and nothing else helps, please contact technical
support at e-mail: chessarchive@mail.ru
Please inform us about the following:
- The program version (Info -> about)
- Windows version (including service packs)
- CPU type and speed, RAM size and screen resolution
- Description of a problem (as much information as possible to retrieve the problem)
- Please, report an error code (the operating system always displays a message-box with name and
code of the error in case of emergency closing of the program). Copy the contents of the box and
send it to tech. support.
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